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JQCALC for Windows
Introduction
Welcome to JQCALC for Windows.

As far as I am aware, this is the first Shareware Windows Spreadsheet, and having written it, 
I now know why this is the first!

The idea behind JQCALC is to produce a fully functional Windows Spreadsheet for the least 
possible cost that would work with Windows version 3.0 and above. It is not designed to 
compete with the big spreadsheet packages. It is a basic, every day, working spreadsheet 
designed to appeal to the millions of people who need a basic spreadsheet and cannot 
justify the cost of the big spreadsheet packages. If you need the extra facilities, just copy the
cells from your Spreadsheet (and graphs in the Registered Version) into your word processor,
it is as simple as that.

Some of the functions in this Shareware version have been removed so that it would fit onto 
a 720kb disk (these functions are included on the Registered Version). This makes it easier 
to distribute and also means that those of you who do not have the most up to date 
computers, or disk drives, can still load it. See the section Limitations for more details.

It may be of interest, but JQCALC is the first Spreadsheet I have written (a good training in 
Systems Analysis and Design helped). Believe it or not, JQCALC is the only Windows 
Spreadsheet I own (I cannot justify the cost of one of the big spreadsheet packages). I do 
have a very basic DOS Spreadsheet that is now pensioned off!

JQCALC is my fourth Windows Shareware program but my first really mainstream Windows 
program therefore I would be grateful for any suggestions you may have on improving 
JQCALC.

John Q. Lavelle
April 1994.
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Disclaimer
All users of JQCALC for Windows must accept this disclaimer. If you do not accept 
this disclaimer, do not use JQCALC for Windows.

The Licence Agreement and Warranty shall be construed, interpreted and governed by the 
Laws of England and Wales. You may have other rights that may vary from one Country 
and/or State to another.

ALL VERSIONS OF JQCALC FOR WINDOWS ARE SUPPLIED AS IS WITHOUT ANY WARRANTY OF 
ANY KIND. JOHN Q. LAVELLE SPECIFICALLY DISCLAIMS ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. WITH RESPECT TO THE DISK AND THE PROGRAMS 
REPRODUCED ON THE DISK, JOHN Q. LAVELLE SHALL HAVE NO LIABILITY WITH RESPECT TO 
ANY LOSS OR DAMAGE DIRECTLY OR INDIRECTLY ARISING OUT OF THE USE OF THE DISK OR 
ANY PROGRAMS REPRODUCED ON THE DISK, EVEN IF THE AUTHOR, HIS AGENTS OR 
EMPLOYEES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. WITHOUT 
LIMITING THE FOREGOING, JOHN Q. LAVELLE SHALL NOT BE LIABLE FOR ANY LOSS OF 
PROFIT, INTERRUPTION OF BUSINESS, DAMAGE TO EQUIPMENT OR DATA, INTERRUPTION OF 
OPERATIONS OR ANY OTHER COMMERCIAL DAMAGE, INCLUDING BUT NOT LIMITED TO 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER DAMAGES.

The Legal Stuff



Copyright
The software and text files are the copyright of John Q, Lavelle unless otherwise stated and 
are protected by the Laws of England and Wales, and other International Treaties. You must 
treat the software like any other copyrighted material.

The Licence only allows you to use the software, it does not give you ownership of the 
software.



Trademarks and Copyrights
Microsoft, MS-DOS, Windows, Visual Basic    are registered trademarks of Microsoft 
Corporation.
JQCALC and J.Q.L. are trademarks of John Q. Lavelle.

Microsoft Corporation: VBRUN300.DLL, EXPAND.EXE, LZEXPAND.EXE, CTL3D.DLL, GRID.VBX, 
COMMDLG.DLL, CMDIALOG.VBX, MMSYSTEM.DLL, VER.DLL, CHIMES.WAV, DING.WAV.

Sheridan Software Systems: THREED.VBX

Stefan Olson: SETUP.EXE (Normally known as INSTALL.EXE.)

John Q. Lavelle: JQCALC.EXE, JQCALC.WAV, JQCALCUR.HLP, JQOOPS.WAV, PRODINFO.TXT, 
REGISTER.TXT, README.TXT, NEW ICON, OPEN Icon, SAVE Icon, SCISSORS Icons, COPY Icons,
PASTE Icon, DELETE Icon, CURRENCY Icon, PERCENT Icon, DECIMAL Icon, SUM Icon, GRAPH 
Icon, PREVIEW Icon, PRINTER Icons.

All other Trademarks and Copyrights acknowledged.



Licence (Shareware)
JQCALC is a Shareware program, and is provided at no charge to users for an evaluation 
period of 30 days. If you wish to use JQCALC after this 30 day period then you must register 
it. If you continue to use JQCALC after the 30 day period without registering it, then you are 
effectively stealing -- it is as simple as that.

Feel free to share JQCALC with your colleagues and friends, but please do not give JQCALC 
away altered or as part of another system without the permission of the author.

You may not rent or lease JQCALC. You may not reverse engineer, dis-assemble or de-
compile JQCALC.

The essence of user-supported software is to provide personal computer users with quality 
software at reasonable prices, and at the same time provide an incentive for programmers 
to continue to develop new products.



Registration Details
Do NOT use this telephone number or address for Support

If you find JQCALC useful and you are continuing to use it after a trial period of 30 days, you
must make a Registration payment of UK £14.95 (Sterling) plus postage and packing to:

Springsoft PC Shareware, Springfield House, LLanfynydd, Wrexham, Clwyd, LL11
5HW, United Kingdom.

Telephone: 0352 770049 International: +44 352 77049 Fax: 0352 770816

Please specify whether you require the Windows 3.0 version or the Windows 3.1 and above 
version. The program is the same for both versions, but different library files and Help File 
are required for the Windows 3.0 version.

The Windows 3.1 (and above) version of JQCALC on a 3.5" HIGH DENSITY (1.44MB) disk is
dispatched unless otherwise advised.

The Registration Fee licenses one copy of the current Registered Version of JQCALC for 
Windows for use on any one computer at any one time. For more information on the 
Registered Licence and Site Licenses please contact John Lavelle.

Credit Card Registrations

Postage and Packing

Special Note for U.S. Users of JQCALC

CompuServe Registrations



CompuServe Registrations

You can Register via CompuServe by typing GO SWREG at the ! Prompt. If you are using 
WINCIM type SWREG in the GO window.

JQCALC's CompuServe Registration ID is:    2432  you will need this number when registering
JQCALC through CompuServe.

The cost of Registration via CompuServe is:

Registration: $30.00 (US Dollars)
Shipping and Handling: $6.00 (US Dollars)

Total: $36.00 (US Dollars)

CompuServe only accepts Credit Card payments and deals in US Dollars. Your Credit Card is 
billed in the currency of your country for the equivalent of $36.00 (US Dollars).

Registration Bonus Certificate

When you register via CompuServe you will automatically receive a Bonus Registration 
Certificate offering you a Bonus CD - The JCSM Shareware Collection -- full of Shareware 
programs and Utilities (3900 on the April 1994 release) at over 50% discount. This CD is 
updated every three months and contains the latest and greatest Shareware Programs. If 
you do not have a CD-ROM player then do not worry, the Certificate is valid for about 18 
months from the date the Certificate is issued, not the date of registration, which gives you 
lots of time before you need to redeem it. Please note that this offer is only for the CD and is
not exchangeable or transferable in any way. Please allow 28 days for delivery. You will 
receive a Bonus Certificate for every copy of JQCALC you register.

If you did not register your copy of JQCALC via CompuServe you may still take part in the CD 
offer. Send your receipt for the Registered Copy(s) of JQCALC to the address below (not to 
CompuServe, International Money Orders or Springsoft) and I will send you the Bonus 
Registration Certificate(s) and return your receipt to you.

John Q. Lavelle
63, Senhouse Street

Siddick
Cumbria
CA14 1LB

United Kingdom

The Bonus Registration Certificate is a special "Thank you" from
John Lavelle, the author of JQCALC.

Do NOT contact CompuServe, International Money Orders or
Springsoft for the Bonus Certificate.



Credit Card Registrations
You can Register using Access, Visa or Mastercard by telephoning:

United Kingdom: 0352 770049 Fax: 0352 770816
International: +44 352 770049 Fax: +44 352 770816

Only use these numbers for Credit Card Orders. For Support and other queries please use 
the telephone numbers in the section Support.

Paying by credit card means you will be charged the equivilent of £14.95 + postage and 
packing in your own currency.



Postage and Packing:
Prices are in Pounds Sterling

United Kingdom £1.95

European Community £3.00

Rest of the World £4.00



Special Note for U.S. Users of JQCALC
You can register through your Post Office.

Do NOT use the Springsoft address for this method of registration,
use my name and address as shown in the following paragraph.

Go to your local Post Office and ask for an Authorization to issue an International Money 
Order in the amount of $36.00 ($30.00 + $6.00 shipping and handling). You must put your 
own name and address on the front of the form, and my name (John Q. Lavelle) and 
address (63 Senhouse Street, Siddick, Cumbria, CA14 1LB, United Kingdom) in the 
Payee's box on the back of the form and JQCALC (along with the disk type and Windows 
version number) in the Notes box. Make sure your name is on the front and my name is on 
the back as it is easy to get this wrong!

The completed form must be mailed to:

International Money Orders,
Box 14964,
St. Louis, MO63182-9421

In St. Louis, the money is converted into British pounds (Sterling) and mailed to me. When I 
receive it, I will send you your Registered Version of JQCALC by return.

This may sound a bit complicated but it does work. It also avoids the ridiculously high bank 
charges that the United Kingdom banks charge -- in some cases nearly the same price as the
program! (I sometimes wonder whether I am working for the Bank or myself.)

My thanks to Dave Jewell for pointing me in the direction of this method of Registration.

Registration Bonus Certificate

When you register using International Money Orders you will automatically receive a Bonus
Registration Certificate offering you a Bonus CD - The JCSM Shareware Collection -- full of 
Shareware programs and Utilities (3900 on the April 1994 release) at over 50% discount. 
This CD is updated every three months and contains the latest and greatest Shareware 
Programs. If you do not have a CD-ROM player then do not worry, the Certificate is valid for 
about 18 months from the date the Certificate is issued, not the date of registration, which 
gives you lots of time before you need to redeem it. Please note that this offer is only for the
CD and is not exchangeable or transferable in any way. Please allow 28 days for delivery. You
will receive a Bonus Certificate for every copy of JQCALC you register.

If you did not register your copy of JQCALC via International Money Orders you may still take 
part in the CD offer. Send your receipt for the Registered Copy(s) of JQCALC to the address 
below (not to CompuServe, International Money Orders or Springsoft) and I will send you the 
Bonus Registration Certificate and return your receipt to you.

John Q. Lavelle
63, Senhouse Street

Siddick
Cumbria
CA14 1LB

United Kingdom

The Bonus Registration Certificate is a special "Thank you" from John Lavelle, the



author of JQCALC.
Do NOT contact CompuServe, International Money Orders or Springsoft for the

Bonus Certificate.
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Installing JQCALC
First you need to set up JQCALC to run on your computer.

Microsoft Windows version 3.0 or greater (from now on referred to as Windows) must be 
installed on your computer. For information on installing and using Windows, please see your
Windows documentation.

Switch on your computer and monitor.

WINDOWS 3.0 users MUST use the file WIN30.BAT instead of SETUP.EXE. If Windows 3.0 
Users use SETUP.EXE the files may not be properly copied across and an error may occur 
reporting DDE problems.

1. Start Windows. If windows is not running, type    WIN    at the command prompt 
(the    C:>    prompt) and press ENTER.

2. Open the Windows Program Manager window. If the Windows Program Manager 
window is not open, then double-click on the Program Manager icon, (or press 
CTRL+ESC to display the Windows Task List, then press the DOWN ARROW or UP 
ARROW key until the Program Manager item is highlighted, then press ENTER).

3. Insert the JQCALC for Windows program disk in your floppy disk drive (if you are 
using a 5 1/4 inch disk or a drive that has a door, then close the door).

4. From the Program Manager window, click on the word FILE to open the menu and 
click on RUN, (or press ALT+F, and press the R key).

5. In the Command Line box, type      A:\SETUP . (If you are using a different drive to 
drive A:, then type the correct drive letter instead of "A:".    e.g. If you are using 
drive B:, then type    B:\SETUP.)

6. Click on the OK button

7. Once the Setup Program has loaded, a series of instructions is displayed on your 
screen, just select the options that best match your system and requirements. We
recommend that the first time you set up JQCALC on your system you use the 
FULL INSTALL option.

8. For users of Windows 3.1 and better JQCALC will create its own Program Group in 
your Program Manager window. Windows 3.0 users will need to create their own 
Program Group. This is due to Windows 3.0 not having the file DDEML.DLL.

9. Check the DRIVERS section of CONTROL PANEL to ensure that the driver [MCI] 
Sound appears in the list of drivers. If it is not listed, click on ADD and enter it 
onto your system. For more information please see your Windows documentation.

NOTES

The Full Installation (recommended) copies ALL the required files to the JQCALC directory. 
The Minimum Install copies all the files EXCEPT for VBRUN300.DLL, DING.WAV and 
CHIMES.WAV. JQCALC will not run without VBRUN300.DLL in either the JQCALC directory or 
your \WINDOWS\SYSTEM directory. The .WAV files are optional.

Check your \WINDOWS\SYSTEM directory for the file VBRUN300.DLL, be careful as you may 



have files with very similar names (i.e. vbrun100.dll or vbrun200.dll). If VBRUN300.DLL is not
in your \WINDOWS\SYSTEM directory you must copy it from the JQCALC directory to your \
WINDOWS\SYSTEM directory. For more information on copying files see your Windows 
documentation or use this example (which should typed all on one line) from the DOS 
prompt.

COPY C:\JQCALC\VBRUN300.DLL C:\WINDOWS\SYSTEM\VBRUN300.DLL

No manual is supplied on the disk because the Help file is always more up to date and is 
recompiled every time there is a change in the program. If you wish a manual then use the 
Print option in the Help file menu to print out each page.

Manually Expand Files

If you experience any problems with any aspect of JQCALC, telephone 0900 
870833 (or International +44 900 870833) or leave a message on CompuServe 
73062,2642. Do not use the Springsoft telephone number or address.

Using JQCALC



Starting JQCALC
You can start JQCALC at any time from the Windows Program Manager.

To start JQCALC from Program Manager.

1. If Windows has not been started, type WIN at the command prompt and then 
press ENTER.

2. In the Program Manager Window, choose the JQCALC group icon.

3. In the JQCALC group window, choose the JQCALC icon to start the program.

After the Registration window is displayed it may take 5 to 20 seconds, depending on your 
system for the JQCALC window to be displayed.



API
Application Programming Interface

Basically this is the set of functions available to programmers to tap into the Windows 
Operating System.



DLL
Dynamic Link Library

Files containing extra functions available to programmers.



Overview
JQCALC is a general purpose Spreadsheet with one worksheet available at any one time. If 
you open more than one copy of JQCALC using the same worksheet then make sure you 
save the correct one! When you have multiple copies of JQCALC open Sharing Violations may
occur if they try to access the same files or Libraries (DLLs) at the same time. To get round 
this, only work on one of the copies at any one time.

Quick Start

To enter text and numbers, move to the required cell and type in the text or number.

To enter a formula, move to the required cell enter an = sign then the formula

e.g. =2+2 or =A1/A16

To enter a function, move to the required cell and enter an = sign then precede the function 
with an @ sign.

E.g. =@SUM(A1:A10)or =A1/@SUM(B10:C20)

To move around the spreadsheet, use the scroll bars or the Home, End, Page Up and Page 
Down keys.

Single cells or groups of cells may be CUT, COPYed , PASTEd and DELETEd within the 
worksheet. They may also be CUT or Copied to and from the Windows Clipboard. See Edit 
Menu for more information.

Columns, groups of columns and single rows can be highlighted and Auto Summed using the
Auto Sum icon or menu option.

Auto ReCalculate can be switched on or off. Press F9 to Calculate Now. Full Error Checking 
can be switched on or off to speed up calculations. The Sound and Hint Line can also be 
switched on or off.

Column widths can be altered by placing the cursor in the top column on the column 
boundary and dragging it wider or narrower. Row height can similarly be altered. Column 
alignment can also be altered. Columns and rows can be inserted or deleted.

There are six different number formats and three different date formats available:

General Number, Currency, Fixed, Standard, Percent, Scientific, General Date, Long Date and
Medium Date.

The Font, Font Colour and Font Style can be altered, but please note that the alterations 
affect the whole worksheet not just a single cell.



Functions and Formulae
Formulae

Formulae start with an = sign and can contain any legal mathematical expression or 
function which is supported by JQCALC. There is a limit of 50 individual formulae per cell.

Operators

+ - * / \ ^
Functions

Functions are preceded by an @ sign, because it makes searching for them quicker when 
recalculating the worksheet. They can contain any legal mathematical expression or cell 
reference that is supported by the function and by JQCALC (remember the = sign).

Mathematical Functions

@ABS(numeric expression)

@ATN(numeric expression in the correct range)

@AVG(cell reference:cell reference)

@COS(numeric expression in the correct range)

@EXP(numeric expression in the correct range)

@FIX(numeric expression)

@INT(numeric expression)

@LOG(numeric expression in the correct range)

@MAX(cell reference:cell reference)

@MIN(cell reference:cell reference)

@RND(numeric expression)

@SEC(numeric expression in the correct range)

@SGN(numeric expression in the correct range)

@SIN(numeric expression in the correct range)

@SQR(numeric expression)

@SUM(cell reference:cell reference)

@TAN(numeric expression in the correct range)



Derived Mathematical Functions

Financial Functions



Cell Reference
In a spreadsheet, rows and columns intersect to form cells. The Cell Reference is the address
of a cell made up from the Column letter(s) and Row Numbers. For example the top left-hand
cell is A1 and the bottom right-hand cell is CU99.



Numeric Expression
A sequence of characters that can be interpreted as a number. Also, any combination of 
variables, constants, functions, cell references and operators that JQCALC can evaluate to a 
number.



Derived Mathematical Functions
The following is a list of the mathematical functions that can be derived from the math 
functions provided with JQCALC:

Function JQCALC equivalent

Cosecant =1/@Sin(X)
Cotangent =1/@Tan(X)
Inverse Sine =@Atn(X/@Sqr(-X*X+1))
Inverse Cosine =@Atn(-X/@Sqr(-X*X+1))+1.5708
Inverse Secant =@Atn(X/@Sqr(X*X-1))+@Sgn(@Sgn(X)-1)*1.5708
Inverse Cosecant =@Atn(X/@Sqr(X*X-1))+(@Sgn(X)-1)*1.5708
Inverse Cotangent =@Atn(X)+1.5708

Hyperbolic Sine =(@Exp(X)-@Exp(-X))/2
Hyperbolic Cosine =(@Exp(X)+@Exp(-X))/2
Hyperbolic Tangent =(@Exp(X)-@Exp(-X))/(@Exp(X)+@Exp(-X))
Hyperbolic Secant =2/(@Exp(X)+@Exp(-X))
Hyperbolic Cosecant =2/(@Exp(X)-@Exp(-X))
Hyperbolic Cotangent =(@Exp(X)+@Exp(-X))/(@Exp(X)-@Exp(-X))
Inverse Hyperbolic Sine =@Log(X+@Sqr(X*X+1))
Inverse Hyperbolic Cosine =@Log(X+@Sqr(X*X-1))

Inverse Hyperbolic Tangent =@Log((1+X)/(1-X))/2
Inverse Hyperbolic Secant =@Log((@Sqr(-X*X+1)+1)/X)
Inverse Hyperbolic Cosecant =@Log((@Sgn(X)*@Sqr(X*X+1)+1)/X)
Inverse Hyperbolic Cotangent =@Log((X+1)/(X-1))/2

Logarithm =@Log(X)/@Log(N)



Financial Functions
The following functions are available in the Registered version only

@DDB - Double Declining Balance,
@FVL - Future Value,
@IPM - Interest Payment for a given Period,
@NPR - Number of Periods for an Annuity,
@PMT - Payment for Annuity,
@PPT - Principal Payment,
@PVL - Present Value,
@RTE - Interest Rate,
@SLN - Straight Line Depreciation,
@SYD - Sum of Years' Depreciation.



+
Used to sum two numbers.

Usage

=operand1+operand2

Notes

Operand1 and operand2 can be any valid number, numeric expression or cell reference
Functions and Formulae



-
Used to find the difference between two numbers or to indicate the negative value of an 
operand.

Usage 1

=operand1-operand2

Usage 2

-number

Notes

In Usage 1, the - operator is the arithmetic subtraction operator used to find the difference 
between two numbers. The operands can be any numeric expression or cell reference.



*
Used to multiply two numbers.

Usage

=operand1*operand2

Notes

The operands can be any valid numeric expression or cell reference.



/
Used to divide two numbers and return a floating-point result.

Usage

=operand1/operand2

Notes

The operands can be any numeric expression or cell reference. If division by zero occurs 
then JQCALC returns 0.



\ (Integer Divide)
Used to divide two numbers and return an integer result.

Usage

=operand1\operand2

Notes

The operands can be any numeric expression or cell reference. Before division is performed, 
the operands are rounded to Integer formulae. If division by zero occurs then JQCALC returns
0.



^
Used to raise a number to the power of an exponent.

Usage

=number^exponent

Notes

The number and exponent operands can be any numeric expression or cell reference. 
However, the number operand can be negative only if exponent is an integer value.



ABS
Returns the absolute value of a number.

Usage

@ABS(number)

Notes

The argument number can be any valid numeric expression or cell reference. The absolute 
value of a number is its unsigned magnitude.

For example, =@ABS(-1) and =@ABS(1) both return 1.



ATN
Returns the arctangent of a number.

Usage

@ATN(number)

Notes

The argument number can be any valid numeric expression or cell reference. The ATN 
function takes the ratio (number) of two sides of a right-angled triangle and returns the 
corresponding angle. The ratio is the length of the side opposite the angle divided by the 
length of the side adjacent to the angle. The result is expressed in radians and is in the 
range -Pi/2 to Pi/2 radians. Pi is approximately 3.141593. Pi is not supported by JQCALC.

To convert degrees to radians, multiply degrees by Pi/180. To convert radians to degrees, 
multiply radians by 180/Pi.

ATN is the inverse trigonometric function of TAN, which takes an angle as its argument and 
returns the ratio of two sides of a right-angled triangle. Do not confuse ATN with the 
cotangent, which is the simple inverse of a tangent (1/tangent).



AVG
Calculates the arithmetic mean of a set of values contained in the specified cell references.

Usage

@AVG(cell reference1:cell reference2)

Notes

Cell reference1 (the starting cell) and cell reference2 (the ending cell) can be any legal cell 
reference and are separated with a colon (:). AVG will add all the cells within the range that 
contain a number or numeric expression and divide the result by the number of cells 
containing a number or numeric expression.



COS
Returns the cosine of an angle.

Usage

@COS(angle)

Notes

The argument angle can be any valid numeric expression or cell reference measured in 
radians. The COS function takes an angle and returns the ratio of two sides of a right-angled 
triangle. The ratio is the length of the side adjacent to the angle divided by the length of the 
hypotenuse. The result lies in the range -1 to 1. To convert degrees to radians, multiply 
degrees by Pi/180. To convert radians to degrees, multiply radians by 180/Pi. Pi is 
approximately 3.141593. Pi is not supported by JQCALC.



EXP
Returns e (the base of natural logarithms) raised to a power.

Usage

@EXP(number)

Notes

The argument number can be any valid numeric expression or cell reference. If the value of 
number exceeds 709.782712893, an Overflow error occurs.    The constant e is 
approximately 2.718282.

N.B.

The EXP function complements the action of the LOG function and is sometimes referred to 
as the antilogarithm.



INT, FIX
Return the integer portion of a number.

Usage

@INT(number)

@FIX(number)

Notes

The argument number can be any valid numeric expression or cell reference. Both INT and 
FIX remove the fractional part of number and return the resulting integer value.

If the numeric expression results in a Null, INT and FIX return a Null. The difference between 
INT and FIX is that if number is negative, INT returns the first negative integer less than or 
equal to number, whereas FIX returns the first negative integer greater than or equal to 
number.

For example, INT converts -8.4 to -9, and FIX converts -8.4 to -8.

@FIX(number) is equivalent to:    =@SGN(number)*@INT(@ABS(number))



LOG
Returns the natural logarithm of a number.

Usage

@LOG(number)

Notes

The argument number can be any valid numeric expression or cell reference that results in a
value greater than 0. The natural logarithm is the logarithm to the base e. The constant e is 
approximately 2.718282. You can calculate base-n logarithms for any number x by dividing 
the natural logarithm of x by the natural logarithm of n as follows:

=@LOG(x)/@LOG(n)

The following example illustrates an expression that calculates base-10 logarithms:

=@LOG(X)/@LOG(10)



MAX, MIN
Return the minimum or maximum of a set of values contained in the specified cell 
references.

Usage

@MIN(cell reference1:cell reference2)
@MAX(cell reference1:cell reference2)

Notes

Cell reference1 (the starting cell) and cell reference2 (the ending cell) can be any legal cell 
reference and are separated with a colon (:). If a range of empty cells are specified then MIN 
returns 3.402823E38 and MAX returns -3.402823E38.



RND
Returns a random number.

Usage

@RND(number)

Notes

The argument number can be any valid numeric expression or cell reference. The RND 
function returns a value less than 1 but greater than or equal to 0. The value of number 
determines how RND generates a random number:

Value of number Number returned

< 0 The same number every time, as determined by number.
> 0 The next random number in the sequence.
= 0 The number most recently generated.
number omitted The next random number in the sequence.

The same random-number sequence is generated every time the program is run because 
each successive call to the RND function uses the previous random number as a seed for the
next number in the random-number sequence.



SEC
Returns the ratio of the hypotenuse of a right-angled triangle to that of one side.

Usage

@SEC(number)

Notes

The argument number can be any valid numeric expression or cell reference. SEC is defined 
as 1/@COS(angle).



SGN
Returns an integer indicating the sign of a number.

Usage

@SGN(number)

Notes

The argument number can be any valid numeric expression or cell reference. Its sign 
determines the value returned by the SGN function:

If number > 0,    then =@SGN(number) returns 1.
If number = 0,    then =@SGN(number) returns 0.
If number < 0,    then =@SGN(number) returns -1.



SIN
Returns the sine of an angle.

Usage

@SIN(angle)

Notes

The argument angle can be any valid numeric expression or cell reference measured in 
radians. The SIN function takes an angle and returns the ratio of two sides of a right-angled 
triangle. The ratio is the length of the side opposite the angle divided by the length of the 
hypotenuse. The result lies in the range -1 to 1. To convert degrees to radians, multiply 
degrees by Pi/180.    To convert radians to degrees, multiply radians by 180/Pi. Pi is 
approximately 3.141593. Pi is not supported by JQCALC.



SQR
Returns the square root of a number.

Usage

@SQR(number)

Notes

The argument number can be any valid numeric expression or cell reference that results in a
value greater than or equal to 0.



SUM
Calculates the arithmetic sum of values contained in the specified cell references.

Usage

@SUM(cell reference1:cell reference2)

Notes

Cell reference1 (the starting cell) and cell reference2 (the ending cell) can be any legal cell 
reference and are separated with a colon (:). SUM will add all the cells within the range 
which contain a number or numeric expression



TAN
Returns the tangent of an angle.

Usage

@TAN(angle)

Notes

The argument angle can be any valid numeric expression or cell reference measured in 
radians. TAN takes an angle and returns the ratio of two sides of a right-angled triangle. The 
ratio is the length of the side opposite an angle divided by the length of the side adjacent to 
the angle. If the return value is too large, an Overflow error occurs. To convert degrees to 
radians, multiply degrees by Pi/180. To convert radians to degrees, multiply radians by 
180/Pi.    Pi is approximately 3.141593. Pi is not supported by JQCALC.



WIN30.BAT

Only required with Windows 3.0

WIN30.BAT is a standard DOS batch file which Expands the files from the distribution disk to 
the directory JQCALC. Regardless of which drive or directory you specify for the destination 
directory, the directory JQCALC is created off that drive or directory and the files placed into 
the directory JQCALC. It does not create a Program Group or Program Item for JQCALC, that 
has to be done manually.

WIN30.BAT is best used from the DOS prompt. The full command line instruction is:

WIN30.BAT <source drive[directory]> <destination drive[directory]>

For example if the distribution disk is in drive B: and you wish to install JQCALC to drive D: 
then enter the following at the command prompt. This will place the JQCALC files in D:\
JQCALC.

WIN30.BAT B: D:

If you have downloaded JQCALC from a Bulletin Board and it is in the directory DOWNLOAD 
on drive C: and you wish to install JQCALC on drive C: then enter the following at the 
command prompt. This will place the JQCALC files in C:\JQCALC.

WIN30.BAT C:\DOWNLOAD C:

When all the files have been transferred across, you will need to set up a Program Group 
JQCALC and Program Items for the following files 

JQCALC.EXE JQCALC
JQCALCUR.HLP JQCALC Help File
PRODINFO.TXT J.Q.L. Product Information
REGISTER.TXTRegistration Form

Manually Expand Files



Manually Expand Files
Each file can be manually Expanded if so required. The command for each file (assuming the
distribution disk is in drive A: and the destination directory is C:) is:

VBRUN300.DLL -- Interpreter
A:\EXPAND.EXE A:\VBRUN300.DL_ C:\JQCALC\VBRUN300.DLL

CHIMES.WAV -- Chimes Sound
A:\EXPAND.EXE A:\CHIMES.WA_ C:\JQCALC\CHIMES.WAV

DING.WAV -- Ding Sound
A:\EXPAND.EXE A:\DING.WA_ C:\JQCALC\DING.WAV

COMMDLG.DLL -- For the Standard Dialog boxes
A:\EXPAND.EXE A:\COMMDLG.DL_ C:\JQCALC\COMMDLG.DLL

JQCALC.EXE -- The Main Program File
A:\EXPAND.EXE A:\JQCALC.EX_ C:\JQCALC\JQCALC.EXE

MMSYSTEM.DLL -- Sound Driver
A:\EXPAND.EXE A:\MMSYSTEM.DL_ C:\JQCALC\MMSYSTEM.DLL

THREED.VBX -- 3D effects
A:\EXPAND.EXE A:\THREED.VB_ C:\JQCALC\THREED.VBX

GRID.VBX -- The grid layout on the worksheet
A:\EXPAND.EXE A:\GRID.VB_ C:\JQCALC\GRID.VBX

JQCALC.WAV -- "Welcome to JQCALC" Sound
A:\EXPAND.EXE A:\JQCALC.WA_ C:\JQCALC\JQCALC.WAV

CMDIALOG.VBX -- For the Standard Dialog Boxes
A:\EXPAND.EXE A:\CMDIALOG.VB_ C:\JQCALC\CMDIALOG.VBX

VER.DLL -- Checks the versions of the files on your system
COPY A:\VER.DLL C:\JQCALC\VER.DLL

CTL3D.DLL -- 3D effects for the message boxes
A:\EXPAND.EXE A:\CTL3D.DL_ C:\JQCALC\CTL3D.DLL

JQOOPS.WAV -- OOPS Sound
A:\EXPAND.EXE A:\JQOOPS.WA_ C:\JQCALC\JQOOPS.WAV

PRODINFO.TXT -- J.Q.L. Product Information
A:\EXPAND.EXE A:\PRODINFO.TX_ C:\JQCALC\PRODINFO.TXT

REGISTER.TXT -- The Registration Form
A:\EXPAND.EXE A:\REGISTER.TX_ C:\JQCALC\REGISTER.TXT

JQCALCUR.HLP -- This Help File
A:\EXPAND.EXE A:\JQCALCUR.HL_ C:\JQCALC\JQCALCUR.HLP

Use the version of EXPAND.EXE that is on the distribution disk, not the version in your DOS 
directory.





File Menu
To access the File Menu either click on the word FILE on the Menu Bar or press ALT+F.

The following is the list of options available from the File Menu:

Option Short Cut

Create New File Ctrl+N
Open Existing File... Ctrl+O
Save Ctrl+S
Save As... Ctrl+A

Printer Setup...
Print Ctrl+P
Print Preview

Exit ALT+F4



Create New FileCtrl+N

Creates a new Spreadsheet with all the default options.

This option can be accessed in one of four ways:

1. Click on FILE on the Menu Bar and then on Create New File
-or-
2. Press ALT+F then C.
-or-
3. Press CTRL+N.
-or-
4. Clicking on the Create New File TOOLBAR button

If there is a Spreadsheet open that has not been Saved a message is displayed asking if you 
wish to save the old file. Click on Yes to save it, No to discard it and Cancel to return to it.

The time taken to reset the worksheet depends on how large the old worksheet was.

File Menu



Open Existing File... Ctrl+O

Opens an Existing JQCALC file.

This option can be accessed in one of four ways:

1. Click on FILE on the Menu Bar and then on Open Existing File
2. Press ALT+F then O.
3. Press CTRL+O.
4. Clicking on the Open Existing File TOOLBAR button

If there is a Spreadsheet open that has not been Saved a message is displayed asking if you 
wish to save the old file. Click on Yes to save it, No to discard it and Cancel to return to it.

JQCALC displays a standard Windows Dialog Box that allows you to choose the drive, 
directory and file name of the JQCALC file. For more information on the Standard Dialog 
Boxes please see your Windows documentation.

JQCALC resets the worksheet before loading the file. The time taken to reset the worksheet 
depends on how large the old worksheet was.

Note

JQCALC can only use files in JQCALC format. It cannot use files in other formats.



Save Ctrl+S
Saves a JQCALC file

This option can be accessed in one of three ways:

1. Click on FILE on the Menu Bar and then on Save
-or-
2. Press ALT+F then S.
-or-
3. Press CTRL+S.

If there is no file to Save or the file does not require Saving then this option is ghosted out. If
you still wish to Save the file use the Save As option.

JQCALC displays a standard Windows Dialog Box that allows you to choose the drive, 
directory and file name of the JQCALC file. For more information on the Standard Dialog 
Boxes please see your Windows documentation.



Save As... Ctrl+A

Saves a JQCALC file

This option can be accessed in one of four ways:

1. Click on FILE on the Menu Bar and then on Save As
-or-
2. Press ALT+F then A.
-or-
3. Press CTRL+A.
-or-
4. Clicking on the Save As TOOLBAR button.

JQCALC displays a standard Windows Dialog Box that allows you to choose the drive, 
directory and file name of the JQCALC file. For more information on the Standard Dialog 
Boxes please see your Windows documentation.



Printer Setup...

Changes the current Printer and/or its settings.

This option can be accessed in one of two ways:

1. Click on FILE on the Menu Bar and then on Printer Setup
-or-
2. Press ALT+F then R.

JQCALC displays the standard Windows Dialog Box for altering the Printer Settings. Changes 
made are not local to JQCALC and will need resetting to their old values. For more 
information on the Standard Dialog Boxes please see your Windows documentation.



Print Ctrl+P

Prints the current worksheet

This option can be accessed in one of four ways:

1. Click on FILE on the Menu Bar and then on Print
-or-
2. Press ALT+F then P.
-or-
3. Press CTRL+P.
-or-
4. Clicking on the Print TOOLBAR button.

Print prints in true What You See Is What You Get. It creates a Windows Metafile (WMF) 
Image of the Screen and copies it direct to your printer. JQCALC then scrolls the worksheet to
the next part and copies that and so on until all the used portion of the worksheet has been 
printed.

Pressing the Cancel button aborts the printout.

Because JQCALC is designed as a working spreadsheet, on a standard A4 or 8.5x11 printout 
space will be available at the bottom for you to make notes and the like. To produce high 
quality printouts, it is recommended that the area of the worksheet required is copied to the 
Windows Clipboard and from there, copied into your word processor.



Print Preview

Previews the worksheet as it will appear when printed out.

This option can be accessed in one of three ways:

1. Click on FILE on the Menu Bar and then on Print Preview
-or-
2. Press ALT+F then V.
-or-
3. Clicking on the Print Preview TOOLBAR button.

Print preview displays in true What You See Is What You Get. It creates a full screen image 
of the area of the worksheet, click on OK to move to the next section. JQCALC then scrolls 
the worksheet to the next part and so on until all the used portion of the worksheet has been
viewed.

Pressing the Cancel button aborts the preview.



Exit ALT+F4
Ends your JQCALC session.

This option can be accessed in one of three ways:

1. Click on FILE on the Menu Bar and then on Exit
-or-
2. Press ALT+F then X.
-or-
3. Press ALT+F4.

If there is a Spreadsheet open that has not been Saved a message is displayed asking if you 
wish to save the old file. Click on Yes to save it, No to discard it and Cancel to return to it.

Note

JQCALC saves the state (i.e., on or off) of the Sound and Hint Line menu options in your 
WIN.INI file under the heading [JQCALC].



Edit Menu
To access the Edit Menu either click on the word EDIT on the Menu Bar or press ALT+E.

The following is the list of options available from the EDIT Menu:

Option Short Cut

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Del

Insert Row
Insert Column
Delete Row
Delete Column



Cut Ctrl+X

Moves a cell or a range of cells from an area of your worksheet to the Windows Clipboard.

First highlight the cell or range of cells to be moved then choose one of the following 
methods of cutting the cells.

1. Click on EDIT on the Menu Bar and then on Cut
-or-
2. Press ALT+E then T.
-or-
3. Press CTRL+X.
-or-
4. Clicking on the Cut TOOLBAR button

The value's cell or range of cells have now been copied to the Clipboard in tab delimited 
format and to the internal JQCALC clipboard in JQCALC format.

If the cell or the range of cells are empty then both the Menu option and the TOOLBAR 
button are ghosted out. If the copied cell is empty, only the number format is copied.

When you copy or move cells to another part of the worksheet, JQCALC also copies the 
number format and the cell references.

Edit Menu



Copy Ctrl+C

Copies a cell or a range of cells from an area of your worksheet to the Windows Clipboard.

First highlight the cell or range of cells to be copied then choose one of the following 
methods of copying the cells.

1. Click on EDIT on the Menu Bar and then on Copy
-or-
2. Press ALT+E then C.
-or-
3. Press CTRL+C.
-or-
4. Clicking on the Copy TOOLBAR button

The value's cell or range of cells have now been copied to the Clipboard in tab delimited 
format and to the internal JQCALC clipboard in JQCALC format.

If the cell, the start cell or the range of cells are empty then both the Menu option and the 
TOOLBAR button are ghosted out. If the copied cell is empty, only the number format is 
copied.

When you copy or move cells to another part of the worksheet, JQCALC also copies the 
number format and the cell references.



Windows Clipboard
A temporary storage area in memory for cut or copied information. You can paste the 
contents into another area (or the same area) of a JQCALC worksheet or into another 
Windows application.



Paste Ctrl+V

Inserts a copy of the Clipboard contents in a new location.

First highlight the cell or range of cells where you wish to insert the Clipboard information, 
then choose one of the following methods of pasting the cells.

1. Click on EDIT on the Menu Bar and then on Paste
-or-
2. Press ALT+E then P.
-or-
3. Press CTRL+V.
-or-
4. Clicking on the Paste TOOLBAR button

If you are Pasting from JQCALC, the number format is pasted as well. Any cell references are 
also altered. This can take some time for large worksheets and large areas.

If you are Pasting from another application, the information for each cell must be in Tab 
delimited format with an end of line character -- chr(13) -- at the end of each row. The better
spreadsheets and word processors will either copy data to the Clipboard in this format, or 
give you the option of copying in this format.



Delete Del

Delete a cell or range of cells.

First highlight the cell or range of cells where you wish to delete, then choose one of the 
following methods of deleting the cells.

1. Click on EDIT on the Menu Bar and then on Delete
-or-
2. Press ALT+E then DEL.
-or-
3. Press DELETE.
-or-
4. Clicking on the Delete TOOLBAR button

WARNING

Deleting a cell or range of cells is final! There is no undo in JQCALC.



highlight
You highlight cells in the JQCALC worksheet to tell JQCALC what you want to copy, delete, 
format, move, insert or act upon. To highlight a range of cells place the cursor on the first 
cell, press the left mouse button and while keeping the mouse button pressed, move the 
cursor to the last cell of the range. The background behind the selection changes colour.

The first cell of the range is not highlighted instead a border is placed around it. The same 
applies to single cell highlighting.

Only highlight the cells you require. If for example you highlight the whole of column A by 
clicking on the A, this changes the range of the worksheet, shown on the right-hand of the 
Hint Bar, which makes JQCALC search all the cells in the range each time you recalculate 
regardless of whether they hold a value or not.



Insert Row
Inserts a row into the worksheet at the cursor position.

Highlight the row where you wish to insert a blank row then choose one of the following 
methods to insert the blank row.

1. Click on EDIT on the Menu Bar and then on Insert Row
-or-
2. Press ALT+E then R.

JQCALC will change all cell references of the rows that are moved which can take some time 
on larger worksheets.



Insert Column
Inserts a column into the worksheet at the cursor position.

Highlight the column where you wish to insert a blank column then choose one of the 
following methods to insert the blank column.

1. Click on EDIT on the Menu Bar and then on Insert Column
-or-
2. Press ALT+E then I.

JQCALC will change all cell references of the columns that are move which can take 
sometime on larger worksheets.



Delete Row
Delete a row from the worksheet at the cursor position.

Highlight the row you wish to delete then choose one of the following methods to delete the 
row.

1. Click on EDIT on the Menu Bar and then on Delete Row
-or-
2. Press ALT+E then L.

JQCALC will change all cell references of the rows that are moved which can take sometime 
on larger worksheets.

WARNING

Deleting a row is final! There is no undo in JQCALC.



Delete Column
Delete a column from the worksheet at the cursor position.

Highlight the column you wish to delete then choose one of the following methods to delete 
the column.

1. Click on EDIT on the Menu Bar and then on Delete Column
-or-
2. Press ALT+E then M.

JQCALC will change all cell references of the columns that are moved which can take some 
time on larger worksheets.

WARNING

Deleting a column is final! There is no undo in JQCALC.



Format Menu
To access the Format Menu either click on the word FORMAT on the Menu Bar or press ALT+T.

The following is the list of options available from the Format Menu:

Option Short Cut

Font... Ctrl+F

General Number
Currency
Fixed
Standard
Percent
Scientific
General Date
Long Date
Medium Date

Column Align



Font Ctrl+F
Changes the Font, style, size, effects and font colour.

This option can be accessed in one of three ways:

1. Click on FORMAT on the Menu Bar and then on FONT
-or-
2. Press ALT+T then F.
-or-
3. Press CTRL+F.

JQCALC displays a standard Windows Dialog Box that allows you to choose the font, style, 
size, effects and font colour which is applied to the whole of the worksheet. For more 
information on the Standard Dialog Boxes please see your Windows documentation.

Format Menu



General Number
The default number format for a cell or range of cells. Displays the number as is, with no 
thousand separators.

The number format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of two ways:

1. Click on FORMAT on the Menu Bar and then on GENERAL NUMBER
-or-
2. Press ALT+T then G.

Note

JQCALC hold numbers as 32 bit values. Because of this General Number format cannot 
always display the fractional part correctly. To display a decimal number correctly use one of 
the other number formats.

For Example in cell A1 place the value 0.8 in cell A2 place the value 1 in cell A3 place the 
formula =@SUM(A1:A2). Make sure all three cells are in General Number format and the 
result in cell A3 is 1.79999995231628.



Currency

Displays numbers with thousand separators and the currency character(s) appended to the 
left, if appropriate; displays negative numbers enclosed in parentheses or with a minus sign; 
displays two digits to the right of the decimal separator.

The number format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of three ways:

1. Click on FORMAT on the Menu Bar and then on CURRENCY
-or-
2. Press ALT+T then U.
-or-
3. Clicking on the Currency TOOLBAR button.

Note

Currency uses the International settings and number settings as defined in the International 
section of Control Panel.



Fixed
Displays at least one digit to the left and two digits to the right of the decimal separator.

The number format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of two ways:

1. Click on FORMAT on the Menu Bar and then on FIXED
-or-
2. Press ALT+T then I.

Note

Fixed uses the International settings and number settings as defined in the International 
section of Control Panel.



Standard

Displays number with thousand separators, if appropriate; displays two digits to the right of 
the decimal separator.

The number format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of three ways:

1. Click on FORMAT on the Menu Bar and then on STANDARD
-or-
2. Press ALT+T then A.
-or-
3. Clicking on the Standard TOOLBAR button

Note

Standard uses the International settings and number settings as defined in the International 
section of Control Panel.



Percent

Displays number multiplied by 100 with a percent sign (%) appended to the right; displays 
two digits to the right of the decimal separator.

The number format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of three ways:

1. Click on FORMAT on the Menu Bar and then on PERCENT
-or-
2. Press ALT+T then P.
-or-
3. Clicking on the Percent TOOLBAR button

Note

Percent uses the International settings and number settings as defined in the International 
section of Control Panel.



Scientific
Uses standard scientific notation.

The number format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of two ways:

1. Click on FORMAT on the Menu Bar and then on SCIENTIFIC
-or-
2. Press ALT+T then S.

Note

Scientific uses the International settings and number settings as defined in the International 
section of Control Panel.



General Date
Displays a date and/or time.

For real numbers, displays a date and time. (E.g. 4/3/93 05:34 P.M.); If there is no fractional 
part, displays only a date (e.g. 4/3/93); if there is no integer part, displays time only (e.g. 
05:34 P.M.).

The Date format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of two ways:

1. Click on FORMAT on the Menu Bar and then on GENERAL DATE
-or-
2. Press ALT+T then D.



Long Date
Displays a date.

Displays a Long Date, as defined in the International section of the Control Panel.

The Date format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of two ways:

1. Click on FORMAT on the Menu Bar and then on LONG DATE
-or-
2. Press ALT+T then E.



Medium Date
Displays a date.

Displays a date in the same form as the Short Date, as defined in the International section 
of the Control Panel, except spell out the month abbreviation.

The Date format of the current cell is displayed on the Hint Bar.

This option can be accessed in one of two ways:

1. Click on FORMAT on the Menu Bar and then on MEDIUM DATE
-or-
2. Press ALT+T then M.



Column Align
Displays a second menu with the following options:

Left
Right
Center

Align the whole column in one of those formats.



Options Menu
To access the Options Menu either click on the word OPTIONS on the Menu Bar or press 
ALT+O.

The following is the list of options available from the Options Menu:

Option Short Cut

Show Grid Lines

Auto ReCalculate
Calculate Now F9
Auto Sum

Full Error Checking
Sound
Hint Line



Show Grid Lines
Toggles the Grid Lines on or off.

This option can be accessed in one of two ways:

1. Click on OPTIONS on the Menu Bar and then on SHOW GRID LINES
-or-
2. Press ALT+O then L.

The Grid Labels are always shown.

The Grid Lines are never shown in print outs.

Options Menu



Auto ReCalculate
Toggles Auto ReCalculate on or off.

This option can be accessed in one of two ways:

1. Click on OPTIONS on the Menu Bar and then on AUTO RECALCULATE
-or-
2. Press ALT+O then R.

The current state of Auto ReCalculate is displayed in the first box on the Hint Bar as Auto 
ReCalc or Manual Calc.

Note

On large worksheets it can take quite some time to recalculate the whole sheet, therefore it 
maybe advantageous to turn off Auto ReCalculate and use the F9 key whenever you need to 
recalculate the worksheet.



Calculate Now F9
Immediately recalculate the whole worksheet.

This option can be accessed in one of three ways:

1. Click on OPTIONS on the Menu Bar and then on CALCULATE NOW
-or-
2. Press ALT+O then N.
-or-
3. Pressing the F9 key

Displays Calculating in the third box on the Hint Bar



Auto Sum

SUMs a range of cells and places the result after the last cell of a range in a single row; or 
below the last cell of a range in columns.

First highlight a range of cells then choose one of the following methods of activating Auto 
Sum:

1. Click on OPTIONS on the Menu Bar and then on AUTO SUM
-or-
2. Press ALT+O then M.
-or-
3. Clicking on the Auto Sum TOOLBAR button

Note

If a single cell is selected the following formula is placed in the formula line:    =@SUM( ready
for you to complete.



Full Error Checking
Toggles Full Error Checking on or off.

This option can be accessed in one of two ways:

1. Click on OPTIONS on the Menu Bar and then on FULL ERROR CHECKING
-or-
2. Press ALT+O then K.

WARNING

Spurious results may occur if an error is encountered. Only use this option when 
you are 100% certain that your worksheet is error free.

Note

This option does not turn off all the error checking, only parts of it and is useful in speeding 
up the recalculation of large worksheets.



Sound
Toggles the Sound on or off.

This option can be accessed in one of two ways:

1. Click on OPTIONS on the Menu Bar and then on SOUND
-or-
2. Press ALT+O then U.

JQCALC stores the state of this switch in your WIN.INI file under the heading [JQCALC]. 
Sound=0 (FALSE) is off, Sound=-1 (TRUE) is on.

The driver [MCI] Sound must be loaded in the DRIVERS section of Control Panel for this 
option to operate.



Hint Line
Toggles the Hint Line on or off.

This option can be accessed in one of two ways:

1. Click on OPTIONS on the Menu Bar and then on Hint Line
-or-
2. Press ALT+O then I.

As the cursor moves over the JQCALC window the functions of the areas it passes over are 
displayed at the left-hand of the Hint Bar. If a button is unavailable (ghosted out) then the 
Hint Line is blank.

JQCALC stores the state of this switch in your WIN.INI file under the heading [JQCALC]. Hint 
Line=0 (FALSE) is off, Hint Line=-1 (TRUE) is on.



Help Menu
To access the Help Menu either click on the word HELP on the Menu Bar or press ALT+H.

The following is the list of options available from the Help Menu:

Option Short Cut

Contents F1
Help on Help Shift+F1
Functions

About Ctrl+B

Register Ctrl+R



Contents F1
Displays the Contents section of this Help File.

This option can be accessed in one of three ways:

1. Click on HELP on the Menu Bar and then on CONTENTS
-or-
2. Press ALT+H then C.
-or-
3. Pressing the F1 key gives context sensitive help.

Help Menu



Help on Help Shift F1
Displays the Windows Help File.

This option can be accessed in one of three ways:

1. Click on HELP on the Menu Bar and then on HELP ON HELP
-or-
2. Press ALT+H then H.
-or-
3. Pressing the SHIFT+F1.



Functions
Displays a brief list of the functions and operators supported by JQCALC.

This option can be accessed in one of two ways:

1. Click on HELP on the Menu Bar and then on FUNCTIONS
-or-
2. Press ALT+H then U.

Click on OK or press ENTER to close this message window



About Ctrl+B
Displays the Copyright Information and Version Information on JQCALC.

This option can be accessed in one of three ways:

1. Click on HELP on the Menu Bar and then on ABOUT
-or-
2. Press ALT+H then B.
-or-
3. Pressing CTRL+B.

Click on OK or press ENTER to close this window.



Register Ctrl+R
Displays the Registration Information.

This option can be accessed in one of three ways:

1. Click on HELP on the Menu Bar and then on REGISTER
-or-
2. Press ALT+H then R.
-or-
3. Pressing CTRL+R.

Click on REGISTER.TXT to open Windows NOTEPAD with the Registration Form. Click on OK to 
close the window. For more information on Windows NOTEPAD please see your Windows 
documentation.



Graphics

This option is only available in the Registered Version

A full complement of graph functions are available in the Registered Version including 
Saving, loading, Copying and Printing.

Graph Types include:

Pie Charts
Bar Graphs
Gantt Charts
Line Graphs
Log/Lin Graphs
Polar Graphs
Scatter Graphs
High-Low-Close Graphs

Many of the Graph Types also support 3D.

Registering really is worth it!



Limitations
JQCALC was designed to a price and a very competitive price at that. Therefore there are 
certain things it cannot do (but you never know what the next version may include) which 
are common place on some budget DOS spreadsheets.

1. Text can only be placed in its own cell. It cannot overrun adjacent cells. Row 
Height and column Width can be adjusted to make it fit.

2. Fonts, Font Styles, Font Sizes and Font Effects affect the whole spreadsheet, 
not just a single cell.

3. Printing has been designed as very basic (mainly to keep the size down). If 
you require good quality output, copy the required cells to your word 
processor.

4. General Number: JQCALC holds numbers as 32 bit values, therefore the 
General Number format cannot always display the fractional part correctly. To 
display a decimal number correctly use one of the other number formats.
For Example in cell A1 place the value 0.8 in cell A2 place the value 1 in cell 
A3 place the formula =@SUM(A1:A2). Make sure all three cells are in General 
Number format and the result in cell A3 is 1.79999995231628.

5. Recalculation and Pasting can take quite some time on larger sheets 
(recalculating the full 10000 cells (including 1500 formulae) takes over 12 
minutes on a 386SX 25Mhz and just 4 minutes on a 486DX2 66Mhz -- I doubt 
very much that you will ever require JQCALC to produce a 10000 cell 
worksheet). Please be patient or turn off Auto ReCalculate. The Formula Line 
will display JQCALC's progress. The Registered Version uses a different method
to recalculate the worksheet which brings the time taken dramatically down 
depending on the number of formulae in your worksheet.

6. This version of JQCALC was written using Visual Basic. This means that it does 
not really need a co-processor as much as it requires a fast processor and 
memory. 4MB of memory and above is recommended regardless of the type of
computer, though it will work on a 286 with 2MB running Windows 3.0 but the 
recalculation times are very slow (my guess is about 25 minutes for a 10000 
cell worksheet!).

7. The Shareware version (this Version) of JQCALC has been "trimmed" to fit on a 
720 KB disk (have a look at the bytes free figure at the bottom left of the File 
Manager Window). This means that various functions have had to be left out, 
Graphs, Financial Functions and faster recalculating. The graphics libraries and
drivers alone come to approximately 500KB!

The Registered Version of JQCALC is supplied with all these functions 
so it really is worth while Registering.

8. JQCALC does not support UNDO, though we are looking at ways of 
incorporating it in later versions. When you Register, you automatically 
receive the Latest Version whereas this Shareware Version is only upgraded on
major version releases (about once a year).

9. In simple terms, the Windows operating system needs access to the processor
to update events and windows. JQCALC yields to Windows during Calculations 



after every tenth row has been calculated. Therefore certain events may be 
delayed on machines with slower processors and large worksheets (use 
shorter rows and longer columns when running other time-critical Windows 
programs).



JQCALC for Windows

General Information
Files
Error Messages
Support
About Shareware



Files

You make any changes to your system entirely and totally at your
own risk.

You must read and agree to the Disclaimer in the section The Legal Stuff before you read any
further, install JQCALC or make any of the changes detailed below.

The SETUP program copies all the files required by JQCALC to the JQCALC directory. No files 
are copied to any other directory.

JQCALC makes an entry in your WIN.INI file called [JQCALC]. It keeps the state of the Hint 
Line switch and Sound switch in this section.

Some of the files copied to the JQCALC directory may already be on your computer. Some of 
these files in the JQCALC directory may, therefore, be deleted if they are already in your \
WINDOWS\SYSTEM directory. Only delete these files if you are an experienced Windows user,
already have these files in your \WINDOWS\SYSTEM directory and sure of what you are 
doing. If in doubt, leave well alone!

VBRUN300.DLL
CHIMES.WAV
DING.WAV
COMMDLG.DLL
MMSYSTEM.DLL
VER.DLL

If you experience problems with JQCALC after deleting any of these files please Manually 
Expand them from the distribution disk back to your JQCALC directory.

IMPORTANT

Certain files are not compatible with files of the same name located elsewhere on 
your system (for which we have Microsoft to thank!). It is very strongly 
recommended that the following files are not deleted or moved from the JQCALC 
directory.

CTL3D.DLL
GRID.VBX
THREED.VBX
CMDIALOG.VBX

These files are not backwards or forward compatible. Therefore, although your system may 
operate correctly if you move or delete these files, when you add a package which uses a 
different version of any of these files, either the package may not operate, or other 
programs, not just JQCALC, may not function correctly.

Uninstall

If for some reason, though I cannot think why, you wish to remove JQCALC from your system.
Delete the directory JQCALC, the program group JQCALC and edit the WIN.INI file and delete 
the section [JQCALC].

WARNING



When editing your WIN.INI file ALWAYS make a backup first. If in doubt, leave well
alone!

General Information



Error Messages
There are two basic types of Error Message that may be displayed by JQCALC. They are 
JQCALC's own Error Messages and Standard Error Messages.

The Standard Error Messages are displayed when something happens that the system does 
not like and usually have a number in the range 3 to 31017 followed by (if you are lucky) a 
terse message.

JQCALC's Error Messages are in the Range 32758 to 32767 and are as follows:

32767 " Calculation Stack Overflow" Over 50 functions in one cell
"This expression is too complex for me!"

32766 " Close Bracket Error" 
"You have more OPEN brackets than CLOSE brackets!"

32765 " Open Bracket Error"
"You have more CLOSE brackets than OPEN Brackets!"

32764 " Colon Error"
"Check the number of COLONS in your expression"

32763 " Paste Error"
 "The area you are Pasting to must either be"
"The same size or an exact multiple of the data CUT or COPYed"

32762 "File Name" If JQCALC cannot open the named file
"This file is not in JQCALC format or has been corrupted"

32761 " Paste Error" JQCALC cannot understand the contents of the Windows 
Clipboard.
"To PASTE over a range of Cells the item must be in JQCALC format"

32760 " Copy Error" If you select an area yet to be used!
"The range you have selected is invalid"

32759 " Cell Reference Error" Cell reference is outside the area used -- turn off 
AUTO RECALCULATE if you are making a forward reference
"The Cell Reference is invalid"

32758 " Function not recognised"
"The function is either not supported"
"in this version of JQCALC"
"or has been incorrectly entered."



Support
The following Telephone numbers and address are for support only. Do not use 
these numbers or address for Registrations.

In the Registered Version of JQCALC you have unlimited support. Just dial the Support 
number given below or contact J.Q.L. on the CompuServe address shown below.

In this Shareware Version of JQCALC "get you working" support is available. This means if 
you have problems installing JQCALC or creating your First Spreadsheet then you can call the
Support number given below or contact J.Q.L. on the CompuServe address shown below.

Telephone United Kingdom: 0900 870833
Telephone International: +44 900 870833

Fax United Kingdom: 0900 870833
Fax International +44 900 870833

CompuServe: 73062,2642

Address:

John Q. Lavelle,
J.Q.L.,
63, Senhouse Street,
Siddick,
Cumbria,
CA14 1LB
United Kingdom.

Notes

(0900 is the exchange for Workington\Cockermouth, Cumbria and not one of these funny 
numbers!)

For all Support Calls, you must contact me. If you get the Answering Machine then please 
phone me back. British Telecom's rates make it uneconomic for me to call you and I do not 
want to have to charge for support.

The best time to call is between 11.00 and 12.00 UK time though support is usually available
between 10.00 and 23.30 (either GMT or BST depending on the time of year).

If your data file becomes corrupted, then I can try to fix it for you or extract the data to a 
new file. The conditions are:

1. You must have a Registered Copy of JQCALC.

2. The cost is £15.00(Sterling) + postage and packing which must be enclosed 
with the disk. Cheques are to be made payable to John Q. Lavelle and drawn 
on a British bank. Send the disk and your remittance to the support address 
shown above.

3. The file should be sent to me by Registered Post on a 3.5" or 5.25" disk with as
much information as possible.



4. I will try to make the repairs within five working days, but do not guarantee to 
do so within this time nor do I guarantee to repair the file.

5. Your original file and the repaired file are returned to you. All temporary copies
are destroyed.

6. If you require an express same day service, this can be arranged by 
telephoning me first to make the arrangements. The cost is £50.00(Sterling) +
postage and packing if the transfer takes place by Post or Modem (via 
CompuServe or Internet). For Courier Service then the cost is the same but 
you book and pay the Courier for both legs of the journey. Cheques are to be 
made payable to John Q. Lavelle and drawn on a British bank. Send the disk 
and your remittance to the support address shown above.

7. The charges are not refundable in any way even if I am unable to repair the 
file.



Shareware
"Shareware distribution gives users a chance to try software before buying it.    If you try a 
shareware program and continue using it, you are expected to register.    Individual programs
differ on details -- some request registration while others require it, some specify a 
maximum trial period.    With registration, you get anything from a simple right to continue 
using the software to an updated program with a printed manual."

"Copyright laws apply to both shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below.    Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality.    (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution.    The author specifically grants the right to copy 
and distributed the software, either to all and sundry or to a specific group.    For example, 
some authors require written permission before a commercial disk vendor may copy their 
shareware."

"Shareware is a distribution method, not a type of software.    You should find software that 
suits your needs and wallet, whether it's commercial or shareware.    The shareware system 
makes fitting your needs easier, because you can try before you buy.    And because the 
overhead is low, prices are low also.    Shareware has the ultimate money-back guarantee -- 
if you don't use the product, you don't pay for it."




